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1.0 GEOGRAPHIC INFORMATION SYSTEM (GIS) 
 

GIS is a technological field that incorporates geographical features with tabular data in order 

to map, analyse, and assess real-world problems. It is an organized collection of computer 

hardware, software, geographic data, and personnel to efficiently capture, store, update, 

manipulate, analyze, and display all forms of geographically referenced information. 

 

The main functions of a GIS are: 

 Data Capture 

The input of data into a GIS can be achieved through many different methods of 

gathering. For example, aerial photography, scanning, digitizing, GPS or global 

positioning system is just a few of the ways a GIS user could obtain data. 

 Data Storage 

Some data is stored such as a map in a drawer, while others, such as digital data, can be 

as a hardcopy, stored on DVD, on your hard drive or in the cloud (internet).  

 Data Manipulation 

The digital geographical data can be edited, this allows for many attribute to be added, 

edited, or deleted to the specification of the project.  

 Query and Analysis 

GIS can be used to  analyse your datasets against another and often produces helpful 

trends and data aggregations that serve as the basis for sound decision making. 

 Visualization 

This represents the ability to display your data, your maps, and information 

A GIS is made up of: 

 Hardware 

Computer System, Scanner, Printer, Plotter, Flat Board 

 Software 

GIS software in use are QGIS, MapInfo, ArcGIS, AutoCAD Map, etc. The software 

available can be said to be application specific.  

 Data 

A GIS will integrate spatial data with other data resources and can even use a DBMS, 

used by most organization to maintain their data, to manage spatial data. 

Geographic data and related tabular data can be collected in-house or purchased from a 

commercial data provider.  

 People 

GIS users range from technical specialists to designers and maintenance teams. QGIS 

has a range of developers who contribute plugins that can automate GIS processes. 

 Method 

The map creation can either be automated raster to vector creator or it can be manually 

digitized using the satellite/drone imagery or scanned images.  
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2.0  COORDINATE REFERENCE SYSTEMS 

A coordinate is a set of two or more numbers that specifies the position of a point, line, or 

other geometric figure in relation to some reference system.  

 

The simplest system of this kind is a Cartesian coordinate system. A Cartesian coordinate 

system is simply a grid formed by two adjacent measurement scales, one horizontal (x) and 

one vertical (y). The point at which both x and y equal zero is called the origin of the 

coordinate system.  

2.1   GEOGRAPHIC COORDINATE REFERENCE SYSTEMS 

A geographic coordinate system is designed specifically to define positions on the Earth's 

roughly-spherical surface. Instead of the two linear measurement scales, x and y, the 

geographic coordinate systems are represented by two curved measurement scales. The east-

west scale, called longitude, ranges from +180° to -180°. Because the Earth is round, +180° (or 

180° E) and -180° (or 180° W) are the same grid line. That grid line is roughly the International 

Date Line, which has diversions and passes Taveuni Island. Opposite the International Date 

Line is the prime meridian, the line of longitude defined by international treaty as 0°. The 

north-south scale, called latitude, ranges from +90° (or 90° N) at the North pole to -90° (or 90° 

S) at the South pole.  

The different applications of GIS uses different Coordinate Systems. GIS in aviation and 

marine applications uses Global Projections. The main global projection used is Geographic 

Coordinates using Latitudes and Longitudes, World Grid System (WGS) 1984, EPSG: 4326. 

A second global projection used mainly by surveyors is the Universal Transverse Mercator 

WGS 1984, EPSG: 32760. 

Fiji GIS applications like mapping and boundary definitions need a reprojected system that 

‘fits’ the Fiji Islands much better than global projections. For that purpose, most GIS 

applications and mapping in Fiji uses the Fiji Map Grid, WGS 1986, EPSG: 3460. 

You’ll most likely use one of these three for Forestry applications and mapping in Fiji. 

Diagram of a Cartesian coordinate system 
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3.0   THE QGIS INTERFACE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.0   DATA FORMATS AND STRUCTURE 

QGIS can open a lot of data formats.  

Formats that QGIS can open include: 

Vector Raster 

 Shapefiles  .SHP Joint Photograpic Experts Group  .JPEG, .JPG 

MapInfo files  .TAB Bitmap Picture  .BMP 

GPS Exchange Format  .GPX Enhanced Compression Wavelet  .ECW 

Autocad Files  .DWG Tagged Image File Format  Geotiff, .TIF 

Key Markup Language  .KML, KMZ Key Markup Language  .KML, KMZ 

 

The data structure is dependant on the user and the feature that will be captured. 

For example: 

For features with boundaries like Harvest Area, you’ll need an area field with a decimal feature type. 

Utilising the Field Calculator, you’ll select the Update existing field checkbox and use the $area 

formula to tabulate your area field.  

New project Drop down menu with more tools 

Project projection Layers panel 

Create new shapefile 

Layers panel 

Mapping Window 
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5.0   CREATING VECTORS 

 Click on   to create a new vector layer 

  

 

 

 

 

 

 

 

 

 

DIGITISING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 Click on the image and begin digitising  

 Right click to close/end digitising  

 Fill attribute table 

Type Filename in work folder 

(Not in Program Files:\) 

Attribute field names 

Data type 

Max number of letters for field 

Press OK to proceed 

      Select layer 
1 1 

       Toggle Editing 
1 2 

      Add feature 
1 3 
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6.0  DATA THEMES 
This refers to how we change layer properties (Colours/Labels) 

 Right click on target layer 

 Click Properties 

 

 

 

 

 

 

 

 

 

 

 

 

7.0  UPDATE AREA FIELD 
 Click Project tab  Project Properties and General section 

 Select appropriate units for measurement 

 

 

 

 

 

 

 

 

 

 

Click to edit appearance 

Click No brush  to have “no fill” 

Select a visible stroke according to 

your background 

Stroke width 

User specified units 
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Change to Hectares 

 

 Click the Field Calculator tool   

 

 

 

 

 

 

 

 

 

 

 

 Click OK to proceed 

8.0  VECTOR EDITING 
 

 Use      to select features on the map window. Selected features are shown in yellow. 

 To combine 2 features, select both, click on Edit and click Merge Selected Features. 

 

Clip creates a new shape based on the area of the input layer that is overlapped by the 

clipping layer. 

 

Difference creates a new feature based on the area of the input layer that isn’t 

overlapped by the clipping layer. 

 

 

 

 

 

 

 

Check to update existing field 

Select existing field 

Click Geometry and double click 

$Area 
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9.0  THE GEOREFERENCER TOOL 
Historic maps can be ‘georeferenced’ and used as backdrops for GIS. The ‘Georeferencer 

GDAL’ plugin can be enabled (Check box) in the Plugins menu. 

 

 

 

 

 

 

 

The tool Georeferencer can be accessed under the Raster menu 

 

 

 

 

Click on           and browse to the raster image that you need to georeferenced 

 

 

 

  

Georeferencer Window 

GCP from GIS Map 

Click to Add Points on 

Georeferencer window 

on features common in 

both images 

Ground Control Point (GCP) 

Click on Transformation Settings  to set your preferred transformation parameters 

Two important parameters to configure correctly here are Transformation Type and Target SRS 

(Projection) 
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A good georeferenced image will sit perfectly on the raster backdrop. Good features to use for this 

purpose include road junctions, prominent building features, ridges and valleys and certain 

hydrological features 

10.0  DIGITISING NETWORKS (ROADS, HYDROLOGY ETC) 
Important to enable Snap from Project Menu (Snapping Properties) when digitising connected 

networks. 

 

 

 

 

 

 

 

 

 

 

 

 

Change to 

Polynomial 1 

Change to FMG 

EPSG 3460 

Correct 

Incorrect 
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11.0  ADVANCED LABELLING 

 Access the labels in properties and click ’Single Labels’  

 Click the ’Label with’ drop down menu and select the layer you want to label your 

features with. 

To show two or more field labels you’ll have to use a formula. 

Access the formula field by clicking on     next on the label with  drop down box. 

 

Use the formula below to label the corresponding harvest plan map with more than one label 

(as shown below) 

 

 

 ||       Text Separator 

 '\n'     Creates a new line 

 "Area"  Put inside "  " the field names in your attribute table 

 'Sample'    Put inside '  '  any additional text you want shown eg. units  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

'Species' ||':' ||' ' ||  "Type" ||  '\n'  || "Area" || 'Ha' ||  '\n'  || "Area-Acres" ||'Acres' 
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12.0  ONLINE IMAGE SOURCES – XYZ Tiles 

Various online imagery providers host data on their servers which could be accessed through 

the XYZ Tiles connection. You will need internet connectivity to access these files. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Load the XYZ.XML file  

Viti Levu with Esri Satellite backdrop 
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13.0  MAP PRODUCTION – Layouts 

Map Layout is the assembling of the various elements of a map into a single whole, including the map 

itself, its legend, title, scale bars, and other elements. 

LEGEND 

A map legend, or map key, is an explanation of the symbols or pictorial language and convention of 

the map. Legend content, design and placement are important because a map can fail to 

communicate its message if readers cannot determine what the symbols in the map are intended to 

represent." Not all symbols used on the map necessarily need to be included in the legend; Symbols 

that are intuitive, conventional, well-labeled, or unimportant may be left out with careful 

consideration. Maps with highly standardized symbology, such as street maps or topographic maps, 

may remove the legend altogether.  

 

 

 

Elements of legend design  

 A legend includes four parts: content, wording, placement, and style. 

 Symbols must look exactly like the symbol used on the map in order to ensure viewer 

comprehension. This is particularly important in regards to size. 

 The legend title should be explanatory and make a clear connection to the map’s legend. 

 

MAP TITLE 

The title of the map gives the audience the contextual information that they need to use the map 

properly. 

REPRESENTING SCALE 

Including a scale on a map is essential because it explains the size relationship between one and two 

dimensional features on the map and the part of the earth's surface it represents. Zero dimensional, 

or point features, have no size relationship with the map scale. There are three common ways to 

represent scale on a map:  

 A scale bar, a ruler-like visual depiction of map distances to scale. 

 A representative fraction, giving the mathematical ratio between distances on the map and 

distances on the ground (e.g., 1:25,000). 

 A verbal scale, which describes a scale by comparing common map and ground measurements, 

such as '1 inch equals 2 miles 

 

INSET MAPS 

Inset maps are small maps projected onto the main map, which are used to depict an area of the map 

at a larger or smaller scale for a particular purpose 

GRIDS 

Grid references define locations in maps using Cartesian coordinates. Grid lines on maps define the 

coordinate system, and are numbered to provide a unique reference to each location on the map. 
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14.0   SAMPLE LAYOUTS 

 

 

 

 

 

 

 

 

 

 

 

 

 

           


